ECM ENGINE CONTROL
AND MONITORING

Lambda 5220

Single/Dual Lambda Analyzer

Instruction Manual

9/1/14




© COPYRIGHT 2007, 2014 by ECM: ENGINE CONTROL AND MONITORING.
All Rights Reserved.

No part of this manual may be photocopied or reproduced in any form without prior written
consent from ECM: ENGINE CONTROL AND MONITORING.

Information and specifications subject to change without notice.

Printed in the United States of America.



Table of Contents

Introduction 1

The Lambda 5220
Lambda 5220 Kit Contents

How to Use
Hooking up the Lambda 5220 4
Mounting the Lambda Sensor and Pressure Sensor 10
Front Panel and the “SYS” Key 11
MOd (Module) Setup Option 13
RATE Setup Option 13
FUEL Setup Option (H:C, O:C, N:C, H2) 13
AOUT (Analog Output) Setup Option (Al to A6) 13
dISP (Display) Setup Option (P1 to P8) 16
CAL (Calibrate) Setup Option (02, P, AVG, SKEW) 16
CONF (Configure) Setup Option (LEdS, 1V4V, CAN, LOCK, FACT) 19
Specifications and Limits 21
Measurements and Accuracies 21
Sensor Limits and Specifications 21
Output Specifications 23
General Specifications 24
Appendices 25
A. 5200 Series Instruments Parts List 25
B. Module EIB Mode and Stand-alone Mode 31
C. Error Codes and Troubleshooting 35
D. Calculating the %O, in Air 36
E. LOCKing and unLOCKing Display Head 37
F. Using the Configuration Software 38
G. Setting up ETAS INCA for ECM Analyzers 41
H. Setting up ATI Vision for ECM Analyzers 47
I. Using the Lambda (O;) Sensor Simulator 54
Safety Warnings 55

Warranty and Disclaimers 56







Introduction

The Lambda 5220

The Lambda 5220 is a powerful, “next generation” wideband lambda and O, analyzer that
packs the following features into a small and easy-to-use package:

¢ Single or dual channel lambda sensor operation

e Lambda 5220 systems can be linked together for multi-cylinder monitoring

e Displays in A (Lambda), AFR (Air-Fuel Ratio), ® (Equivalence Ratio), %0,', and
FAR? (Fuel-Air Ratio) units

e Wide range of operation: A: 0.4 10 25.0
AFR: 6.0 to 364.0
®: 0.04 t0 2.5

%0, 0.0 t0 25.0
FAR?: 27 to 1667

Uses NTK (NGK Spark Plug) and Bosch lambda sensors

Pressure compensation3 for A, AFR, @, %0,, and FAR

Can specify any fuel type by H:C, O:C, and N:C ratios, including H,
Exhaust pressure measurement range3: 0to 517 kPa (75 Psia)

All lambda and pressure’ sensor parameters available for display and output
Easy lambda sensor calibration using ambient air

Calibration data for lambda sensor stored in sensor’s connector
Calibration data for pressure sensor stored in sensor’s connector®

Six programmable 0 to 5 VDC analog outputs

CAN output and .dbc generation software

Up to 100 m between lambda sensor and display possible

“Lockout” feature for front panel of display

Power on/off can be controlled by external “key” signal

11-28 VDC and 95-250 VAC* operation

Lambda 5220 analyzers can use either LambdaCAN or LambdaCANp modules.
LambdaCAN modules use 4-terminal pressure sensors and LambdaCANp modules use 8-
terminal pressure sensors with the pressure sensor’s calibration data stored in a memory chip
in the connector. Lambda 5220 analyzers with LambdaCANp modules are called Lambda
5220B analyzers.

! For stoichiometries richer than Lambda=1, negative %0,s are displayed. This novel convention is
sometimes used with lean-burn engines.

2 FAR x 10000 is displayed. This is the most commonly used way to express FAR. For example, with an
H:C=1.85 fuel, Lambda=1 is FAR=686.8.

® Optional but required for diesel or lean-burn spark-ignition engines

* With optional P/N 04-01 AC/DC Power Supply

® For Lambda 5220 Analyzers using LambdaCANp modules (i.e. Lambda 5220B Analyzers)




Lambda 5220 Kit Contents

The following items are included with a single-channel, Lambda 5220 kit:

Item No. Description Part Number
1. Lambda 5220 Display Head 01-02
2. LambdaCAN Module, or 02-01

LambdaCANp Module 02-08
3. Lambda Sensor, NTK 6 ma, or 05-01
Lambda Sensor, Bosch LSU 4.2, or 05-02
Lambda Sensor, Bosch LSU 4.9, or 05-03
Lambda Sensor, NTK 4 ma 05-04
Others available, contact ECM
4, Eurofast 12 mm Cable, 4 m 09-01
5. Eurofast 12 mm Cable, 2 m 09-02
6. Flexi-Eurofast 12mm Cable, 0.3 m, (3 required) 09-04
7. Eurofast “T”, (4 required) 09-05
8. Eurofast Termination Resistor, (3 required) 09-06
9. Lambda Cable, 1 m 10-02
10. DC Power Cable, Banana Plugs 11-16
1. Female Eurofast to DB9F 11-05
12. Key-on Cable, 2 m 11-08
13. 5200 Series Analyzer and Module Manuals 13-01

and Configuration Software, CD



For pressure-compensation, these additional items are included (per Lambda channel):
Item No. Description Part Number

1. Pressure Sensor with %4” tube fitting (USA), or 07-05
Pressure Sensor with 6 mm (Metric) tube fitting 07-06
(4-terminal sensor for LambdaCAN module)

Pressure Sensor with %4” tube fitting (USA), or 07-10
Pressure Sensor with 6 mm (Metric) tube fitting 07-11
(8-terminal sensor for LambdaCANp module)

2. Module Y Cable (for LambdaCAN module) 10-21
Module Y Cable (for LambdaCANp module) 10-34

3. Pressure Cable, 1 m (for LambdaCAN module) 10-04
Pressure Cable, 1 m (for LambdaCANp module)  10-35

4, Pressure Line Assembly, 28, (USA) 12-08A
Pressure Line Assembly, 711 mm, (Metric) 12-11A

For a dual-channel kit, these additional items are included:

1. LambdaCAN Module, or 02-01
LambdaCANp Module 02-08
2. Lambda Sensor, NTK 6 ma, or 05-01
Lambda Sensor, Bosch LSU 4.2, or 05-02
Lambda Sensor, Bosch LSU 4.9, or 05-03
Lambda Sensor, NTK 4 ma, or 05-04

Others available, contact ECM

3. Eurofast 12mm Cable, 2 m 09-02
4, Flexi-Eurofast 12mm Cable, 0.3 m 09-04
5. Eurofast “T” 09-05
6. Lambda Cable, Im 10-02

Note: If the second Lambda channel is pressure compensated, a set of the pressure-
compensation items listed above are included.

Appendix A contains a list of all 5200 series instruments parts.



How to Use

Hooking up the Lambda 5220

The Lambda 5220 kit consists of 4 parts:

1. The display head
2. The module(s)’
3. The sensor(s)

4. Cabling

The Lambda 5220 is unique in that it puts a control module close to the lambda sensor. There
are several advantages of doing this; the main ones are: improvements in signal-to-noise
ratio, multi-channel capability, simplified cabling, and an almost unlimited sensor-to-display
head distance.

The cable between the display head and module(s) is called the EIB (ECM Instrument Bus)
and carries signal and power. There must be a termination resistor at each end of the EIB.
The EIB can be powered at either the module end (Figure 1) or the display head end (Figure
2). To minimize the power voltage drop on the EIB, it is preferable to power the EIB from
the end closest to the module(s) because that is where most of the power is being consumed
(by the lambda sensor).

Branches/drops to display head(s) and module(s) are made from tees attached to the EIB. Up
to 32 display heads and modules (total) can exist on the same EIB. The EIB cable, tees, and
termination resistors are industry-standard Eurofast 12 mm. The EIB can be extended to a
length of 100 m.

The Lambda 5220 can be turned on and off by the PWR button on the front of the display
head or by a voltage signal (2.7 - 32 V) applied to the KEY connector on the back of the
display head. The current requirements of this voltage signal are very low (100 pA).

After being turned on, the display head will test both displays and all leds and then show:

The display head’s serial number

The version of the display head’s software

The calibration date of the display head (MM.DD YYYY)

The serial number (see Figure B1) of the lambda module assigned to the upper
channel and the serial number of the lambda module assigned to the lower channel.
“....” means no lambda module has been assigned to that channel

“Rotating wheels” and sensor countdowns as they warm up

Parameter data

L=

S

Figures 3 through 5 show details and part numbers of components in Figures 1 and 2.
Optional components are also shown.

! Modules can be setup in EIB Mode or Stand-alone Mode. When the modules are used with a display head,
they must be in EIB mode. See Appendix B for more information.




EIB with Power Entry at Module End

]
Connect \ ﬁ
N Connect Power Entry
e
& = Module
CAN
P
1k 1k II.T "
EIB Connector
Display Head )
}' :
- Q Connect
Lambda Sensor
Pressure
Sensor

Figure 1: Lambda 5220 with Power Entry at Module End



1

16 1k 1k on ux

EIB with Power Entry at Display Head End

AN

Power Entry

CAN

EIB Connector

Display Head

Figure 2:

Lambda Sensor

Pressure
e Sensor

Lambda 5220 with Power Entry at Display Head End
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Figure 3a: Part Numbers of Components on EIB
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Figure 3b: Add above in Location “2” for Second Lambda Channel



P/N 11-08, 2 m
Key-on Cable
(2.7-32 V)

P/N 09-04, 0.3 m
Flexi-Eurofast
Cable

1k 1k 1k

P/N 01-02
Lambda 5220
Display Head

P/N 11-05
Female Eurofast

P/N 09-05
Eurofast

to DB9F

P/N 09-04

N\ ECM
e | TR

Eurofast
Termination
Resistor

T~ CAN
500 kHz
Broadcast

Colg uration Tool
Rc /2.6

coon tou
opes Pasar s

Module
Documentation &
User's Manual
~ =
=

CAN Bus
Connector

P/N 13-01, Manuals and
Configuration Tool

EIB
Connector

P/N 12-01
19” Rackmount Panel

Figure 4a: Part Numbers of Components near Display Head

Lambda 5220
@ /. /AFR SYS
P3/P4
: >3‘AFR u
t @®P7/P8 m )

“

CAN

PIN 3: GND

| www.ecm-co.com

® 9

PIN 4: CAN_H
PIN 8 CAN_L
J__LXC) @
RS232 CASE B GND O

ANALOG OUT 1)

890
@@

USB

Figure 4b: Front and Back of Display Head



Lambda Sensor. One of:

P/N 05-01, NTK 6 mA

P/N 05-02, Bosch LSU4.2
P/N 05-03, Bosch LSU4.9
P/N 05-04, NTK 4 mA

Others available, contact ECM

ECM LambdaCAN
cA ulo

P/N 10-02, 1 m Lambda Cable
Others available, contact ECM

18 mm x 1.5 mm

Connect

P/N 02-01 LambdaCAN Module, or
P/N 02-08 LambdaCANp Module

P/N 10-21, 0.2 m, Module Y Cable
(for LambdaCAN module)

P/N 10-34, 0.2 m, Module Y Cable
(for LambdaCANp module)

P/N 10-04, 1 m Pressure Cable,
(for LambdaCAN module )
P/N 10-35, 1 m Pressure Cable
(for LambdaCANp module)
Others available, contact ECM

P/N 12-08A, 28” Pressure Line
Assembly, (USA)
P/N 12-11A, 711 mm, (Metric)

P/N 07-05 Pressure
Sensor, 0-75 psia, ¥4”,
(USA), or

P/N 07-06, 0-517 kPa,
| 6mm, (Metric)

(for LambdaCAN)

P/N 07-10 Pressure
Sensor, 0-75 psia, Y4”,
(USA), or

P/N 07-11, 0-517 kPa,
6mm, (Metric)

(for LambdaCANp)

¥a> NPT (USA)
¥4 ISO (Metric)

Figure 5: Part Numbers of Components near Module



Mounting the Lambda Sensor and Pressure Sensor

¢ Lambda Sensor

e Threadis 18 mm x 1.5 mm

e Mount between 300 mm from exhaust valve and ten exhaust diameters upstream of
exhaust end.

e Do not exceed 850 °C exhaust gas temperature at location of sensor.
e Mount where condensed material will not collect on sensor.
e Mount upstream of any exhaust catalyst.

¢ Run tap into thread into mounting boss after welding and occasionally to clean
threads.

e Put antiseize on threads and tighten sensor to less than 40 £4 Nm (30 £3 ft-1bf).
e Occasionally clean threads on sensor with small metal brush.

¢ Do not operate engine with lambda sensor not being powered. This may permanently
damage them.

e Route lambda sensor cable away from hot, moving, sharp, or high voltage (spark)
wires.

& Pressure Sensor

e Do not mount pressure sensor directly to exhaust or it will overheat and fail. Always
use the supplied stainless steel/teflon pressure line assembly (P/N 12-11a (Metric) or
12-08a (USA)) between the engine’s exhaust system and the pressure sensor. The
stainless steel end goes towards the engine. Put antiseize on the threads.

e Do not modify the length or diameter of the pressure line assembly.

e Thread on pressure line assembly is %4” ISO or ¥4” NPT (USA).

e Measure pressure within 50 mm of lambda sensor.

e Locate pressure sensor where temperature is between -20 and 80 °C.

e Do not allow condensed material to collect in pressure line assembly.

e Run tap into threads in mounting boss after welding and occasionally to clean threads.

* Route pressure sensor cable away from hot, moving, sharp, or high voltage (spark)
wires.
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Front Panel and the “SYS” Key

The Lambda 5220 display head can be thought of as two single-channel display heads in one
package. One lambda module can be assigned to the upper display, upper four leds, and
analog outputs 1, 2, 3 (i.e. the upper channel) and a second lambda module can be assigned to
the lower display, lower four leds, and analog outputs 4, 5, 6 (i.e. the lower channel). Or one
lambda module can be assigned to both channels. If no module is assigned to a channel,
“....” appears on that channel’s display. More than two lambda modules can exist on the EIB
but a given display head can only show data from two of them. Adding another display head
to the EIB will allow data from another two lambda modules to be displayed.

The display head has two modes of operation: RUN (when measurements or error codes are
displayed) and SYS (where the instrument is set-up). The SYS key toggles between the
modes.

When in RUN mode, the parameter being displayed is indicated by leds to the right of the
display. There are four leds for each display and each led can be red or green. The first four
parameters (A, AFR, @, %O0,) are fixed and the second four (P1, P2, P3, P4) are
programmable from the list of parameters in Table 2. The T and { keys select which of the
eight parameters is displayed (unless the display is LOCKed, see below).

While in RUN mode, pressing the ENT key will toggle between the T and { keys changing
parameters on one channel’s display to changing parameters on the other channel’s display.

In RUN mode, four things other than data can be displayed:

1. “ERR” and “####” where “####” is an error code. See Appendix C.

2. “....” which means that a lambda module has not been assigned to that channel.
See MOd Setup Option.

“---- which means that the display head has an internal problem.

“XXXX” which means that the display is not receiving any data.

“Rotating wheels” and sensor countdowns as they warm up.

Nk

When first entering SYS mode, either “MOd” will be on the upper display or “LOCK” will
be on the lower display. If “MOd” is displayed, the T and | keys will roll through the setup
options (see Table 1). First the options for the upper channel are shown on the upper display,
followed by identical options for the lower channel on the lower display, ending with the
global CONF (Configuration) setup. Pressing the ENT key will select the displayed setup
option and allow its programming.

If “LOCK” is displayed, the display head has been locked and neither the parameters
displayed nor the instrument setup can be changed until it is unlocked. Appendix E describes
how to LOCK and unLOCK the display head.

ECM Lambda 5220
® i /AFR SYS
o
® 0/%02
-IER - :-
i
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Setup Option Level1 Level 2

Function

MOd Select module s/n [NONE)]
RATE Set display update rate [FAST]
FUEL Program fuel H:C,0:C,N:C and if H, [1.85,0,0,NO]
AOUT Al (upper channel) Program analog output 1 [LAM,0V5V,0.400,25.00]
A2 (upper channel) Program analog output 2 [AFR,0V5V,6.000,364.00]
A3 (upper channel) Program analog output 3 [02,0V5V,-25.00,25.00]
A4 (lower channel) Program analog output 4 [LAM,0V5V,0.400,25.00]
A5 (lower channel) Program analog output 5 [AFR,0V5V,6.000,364.00]
A6 (lower channel) Program analog output 6 [02,0V5V,-25.00,25.00]
dISP P1 (upper channel) Program upper display parameter P1 [FAR]
P2 (upper channel) Program upper display parameter P2 [P]
P3 (upper channel) Program upper display parameter P3 [O2]
P4 (upper channel) Program upper display parameter P4 [O2]
P5 (lower channel) Program lower display parameter P5 [FAR]
P6 (lower channel) Program lower display parameter P6 [P]
P7 (lower channel) Program lower display parameter P7 [O2]
P8 (lower channel) Program lower display parameter P8 [O2]
CAL 02 SPAN Calibrate lambda sensor
FACT Reset lambda sensor to factory calibration
AGEF Show age factor for lambda sensor
EXIT
P UNIT Choose pressure units [KPA]
N, C Enter pressure sensor calibration numbers
(for LambdaCAN modules only)
AVG ILAM Program Ip1,%0,,A,AFR,®,FAR averaging [0.375]
PLAM Program P (pressure) averaging [0.375]
EXIT
SKEW P Program gain and offset modifier [1,0]
AFR Program gain and offset modifier [1,0]
PHI (D) Program gain and offset modifier [1,0]
FAR Program gain and offset modifier [1,0]
LAM (1) Program gain and offset modifier [1,0]
02 Program gain and offset modifier [1,0]
CONF LEdS Set display intensity [3333]
V4V Check analog outputs at 1V and 4V
CAN Program CAN addresses, produce .dbc file [1~5],
program CAN transmit and baud rates
LOCK Lock display
FACT RST Reset all but FUEL, N, C, ILAM, PLAM, and ...
EXIT lambda sensor user calibration to [factory defaults]

MOd, RATE, FUEL, AOUT, dISP, and CAL appear on the upper display for the upper channel and
the lower display for the lower channel. CONF appears just on the lower display and is for global

display head setup. All entries must be followed by pressing the ENT key.

Table 1: Menu Tree for the Lambda 5220
[Default values given within square parentheses]|
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MOd (Module) Setup Option

In MOd setup, the serial number of the lambda module assigned to the upper or lower
channel is entered. The serial number is written on a label on the module (see Figure B1).
The module assigned to the upper channel will send information to the upper display and the
analog outputs 1, 2, and 3. The module assigned to the lower channel will send information
to the lower display and the analog outputs 4, 5, and 6. The same module can be assigned to
both channels.

After entering MOd (i.e. press ENT when “MOd” is displayed), the serial numbers of the
available modules on the EIB will displayed. Select using | and ¥ followed by the ENT key.

RATE Setup Option

Different display update rates can be assigned to the upper and lower displays. The selected
display update rate does not affect the analog output update rate or the CAN transmission
rate.

FUEL Setup Option

Fuel H:C, O:C, and N:C ratios and whether or not the fuel is H, can be programmed. This
can be different for the module assigned to the upper channel and the module assigned to the
lower channel (unless the same module is assigned to both channels). The ENT, T, and 4
keys are used for programming. If you get into trouble when programming, press the SYS
key twice to exit and re-enter setup to try again. Fuel H:C, O:C, and N:C ratios and whether
or not the fuel is H, is information stored in the LambdaCAN module.

AOUT (Analog Output) Setup Option

The display head has six programmable analog outputs. Analog outputs 1, 2, and 3 are
programmable on the upper display. Analog outputs 4, 5, and 6 are programmable on the
lower display. Each output can be programmed as 0 to 5V, 0 to 1V, or as an EGO (exhaust
gas oxygen sensor) simulated output.

The analog outputs are updated every 5 ms based on information sent to it by a lambda
module every 5 ms. 5 ms is the maximum rate and is not programmable. The module
averages the data before it is sent at this 5 ms rate. There is one programmable averaging
filter for Ip1, A, AFR, @, %0,, FAR (ILAM) and one for pressure (PLAM). See CAL Setup
Option (AVG Suboption) for more information.

The parameter selected to drive an analog output can be anything from Table 2 if the CONF
MOJE has been set to ENHd (see CONFIG Setup Option) or a subset of Table 2 if the
CONF MOdE has been set to STNd.

Here is an example of setting the analog output 2 (i.e. A2):
1. Press the SYS key until “MOd” is displayed.
2. Press the  key until “AOUT” is on the top display. Then press the ENT key.

3. Press the 4 key until “A2” (analog output 2) is on the display. Then press the ENT
key.

13



9.

Press the T and ¥ keys until the parameter (see Table 2) that will drive A2 is
displayed. Then press the ENT key. Keep in mind that if CONF MOJE is set to
STNd, only a subset of Table 2 will be available.

Press the )F and ¢ keys to select 0 to 5V, 0 to 1V, or EGO sensor simulated output.
Then press the ENT key. EGO sensor simulation is only available on %02, A AFR, ¢
and FAR parameters. If EGO is selected, go to step 8

When 0V is displayed, press ENT. Using the T, J, and ENT keys, set the parameter
value that you want to result in an analog output voltage of OV on analog output 2.
The first time you do this, it may be a little tricky. You are setting one digit at a time
and for some numbers, the display will shift to the left so you can set the right-most
digits. If you get into trouble when programming, press the SYS key twice to exit
and re-enter setup to try again.

When 5V (or 1V) is displayed, press ENT. Using the T, ¥, and ENT keys, set the
parameter value that you want to result in an analog output voltage of 5V (or 1V) on
analog output 2.

If you want the EGO sensor simulated output, when EGO is displayed, press ENT.
Using the T, |, and ENT keys, set the parameter value that you want the lean-to-rich
(OV-to-1V) transition to occur at. OV will be output when lean of the programmed
value and 1V will be output when rich of the programmed value.

When “AOUT” is displayed, press SYS to return to RUN mode.

For analog outputs 4, 5, and 6, your entries will be shown on the bottom display.

14



Parameter

Name

Displayed Full Parameter Name Parameter Description

O2R %02real (%) %02 before addition of Delta O2 curve

IP1 Ipl (mA) Pressure compensated Lambda sensor pumping current
RPVS RPVS (ohms) Lambda sensor internal VS cell resistance

VHCM VH Commanded (V) Desired heater voltage commanded by the module

VS VS (V) Lambda sensor internal VS cell voltage

VP1P VPIP (V) Lambda sensor pumping voltage

VSW Vsw (V) Supply voltage measured at the module

VH VH Measured (V) Actual heater voltage at the module

TEMP Circuit Board Temp (°C) Temperature of the module circuit board

IPIR Iplraw (bits) Lambda sensor pumping current (unsigned integer format)
PR16 Praw16 (bits) 16 bit Pressure sensor output voltage (unsigned integer format)
ERFL/UERF | Error bit flags (bits) Module error flags (unsigned long format)

ERCA/UERC | ECM CANOpen Error Code | ECM CANOpen Error Code

PR10 Praw10 (bits) 10 bit Pressure sensor output voltage (unsigned integer format)
PCF Pressure Correction Factor Lambda sensor pressure compensation correction factor
PCFE ECM diagnostic parameter

O2E ECM diagnostic parameter

IP1E ECM diagnostic parameter

PE ECM diagnostic parameter

P P (mmHg) Pressure sensor measured pressure

LAMR LAMBDAreal Lambda before addition Delta Lambda curve

AFR Air-Fuel Ratio Air-Fuel ratio calculated using LAMBDA (see below)

PHI PHI PHI = 1/LAMBDA

FAR FAR*10000 FAR = (1/AFR) * 10000

LAM LAMBDA Lambda after addition of Delta Lambda curve

02 02 (%) %02 after addition of user-defined curve

IP1X Ip1 non Pcomp (mA) Non-pressure compensated Lambda sensor pumping current
PVLT P (V) Raw volts from pressure sensor

PKPA P (kPa) Pressure sensor measured pressure (abs.) in kPa

PBAR P (bar) Pressure sensor measured pressure (abs.) in bar

PPSI P (psi) Pressure sensor measured pressure (abs.) in psi

PERF Pressure error bit flags Pressure Sensor bit flags (LambdaCANp only)

PERC CANOpen error code ECM CANOpen Pressure Error Code (LambdaCANp only)

Table 2: Parameter List for the Lambda 5220

15




dISP (Display) Setup Option

Parameter information from the lambda module assigned to the upper channel can be
displayed as parameters P1, P2, P3, and P4. Parameter information from the lambda module
assigned for the lower channel can be displayed as parameters P5, P6, P7, and PS.

The parameter selected as P1, P2, etc can be anything from Table 2 if the CONF MOJE has
been set to ENHd (see CONFIG Setup Option) or a subset of Table 2 if the CONF MOdE
has been set to STNd.

Here is an example of setting displayed parameter P2:

Press the SYS key until “MOd” is displayed.

Press the { key until “dISP” is on the top display. Then press the ENT key.

Press the 4 key until “P2” is on the display. Then press the ENT key.

Press the | key until the parameter (see Table 2) that will be P2 is displayed. Then
press the ENT key. Keep in mind that if CONF MOJE is set to STNd, only a subset
of Table 2 will be available.

5. When “dISP” is displayed, press SYS to return to RUN mode.

b

If in the above example, displayed parameter P4 was being programmed, dISP, P4, and your
entries will be shown on the bottom display.

CAL (Calibrate) Setup Option

¢ 02

Lambda sensors supplied with the Lambda 5220 are factory calibrated. This calibration is
stored in a memory chip inside the sensor’s connector. With use, lambda sensors can age
requiring recalibration to maintain measurement accuracy. The SPAN function allows the
user to recalibrate the sensor using ambient air. This user calibration is also stored in the
sensor’s memory chip and is used instead of the factory calibration. The FACT function
cancels the user calibration resulting in the factory calibration being used.

SPAN (calibrate lambda sensor)

To perform a span:

1. A span should be performed after the lambda sensor has been on for at least 20
minutes.

2. Put the lambda sensor and pressure sensor (if so equipped) in ambient, stationary air.
Pressure during lambda sensor calibration is required if the calibration is to be
pressure compensated.

3. Calculate the %0, in air. The %O, of air with no humidity is 20.945. This

percentage decreases with increased humidity. To calculate the %0, in non-zero

humidity air, refer to Appendix D. 20.7 is a common number.

Press the SYS key until “MOd” appears.

Press the ¥ key until “CAL” is on the display of the channel to be calibrated. Then

press the ENT key.

6. With “O2” on the display, press the ENT key.

bk
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7. With “SPAN” on the display, press the ENT key.

8. Using the T and | keys, change the display to show the %0, in air determined in 3
(above). Press the ENT key.

9. When “CAL” is displayed, press SYS to return to RUN model. See AGEF (below).

10. The user calibration is written into the memory chip in the lambda sensor’s connector
and will be used to calculate %0,, A, AFR, ®, and FAR. If the lambda sensor is
removed and installed on another module, this user calibration will go with the sensor
and be used with the new module.

FACT (return to factory lambda sensor calibration)

To return to the factory calibration for the lambda sensor:

Make sure the lambda sensor is attached to the module.

Press the SYS key until “MOd” appears.

Press the ¥ key until “CAL” is on the display of the channel to be calibrated. Then
press the ENT key.

With “O2” on the display, press the ENT key.

Press the 4 key until “FACT” is on the display. Press the ENT key. The user
calibration of the lambda sensor is erased and the factory calibration will be used to
calculate %0,, A, AFR, ®, and FAR. The lambda sensor age factor (AGEF) will be
reset to “1.00”.

W=

e

AGEF (lambda sensor age factor)

After the lambda sensor has been user calibrated, data from this calibration is compared to
data taken from the sensor when it was new. From this, a parameter (AGEF) is calculated
that indicates the relative sensitivity of the sensor compared to when it was new. If AGEF is
1.00, the sensor’s sensitivity has not changed. AGEF goes down with use. When the AGEF
i1s 0.75 or below, it is recommended that the lambda sensor be replaced. AGEF is reset to
“1.00” after the FACT option (see above) has been executed. The age factor is applicable
when SPAN’d at zero altitude or when pressure compensation is used.

+ P (only active for pressure-compensated systems)
UNIT

Pressure is displayed as absolute and the available pressure units are: mmHg, kPa, bar, and
psi. The raw pressure sensor output voltage can also be displayed.

N, C (for LambdaCAN only, not LambdaCANp)
For Lambda 5220 analyzers that use LambdaCAN modules and are pressure-compensated,

the pressure sensor calibration numbers (N and C) must be entered. The “N” and “C” values
are written on a label on the pressure sensor.

N=18.7370
REERE 00076 N

KPa max.
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For the case of LambdaCANp modules, the pressure sensor calibration numbers are stored in
a memory chip inside the sensor’s connector (similar to the Lambda sensor). These numbers
are read by the LambdaCANp module as soon as the sensor is connected.

Pressure sensors are not user-recalibratable.
¢ AVG

Raw data is sampled from the lambda sensor pressure sensor every 5 ms. This data is
averaged by the lambda module every 5 ms before being sent to the display head every 5 ms.
For the parameters Ip1, %0,, A, AFR, ®, and FAR, the averaging filter (also called recursive
averaging filter or digital low-pass filter) is ILAM. For pressure, the averaging filter is
PLAM. How the averaging filters are used is shown by Equation 1. The averaging filters are
user-programmable and can be assigned values from 0.001 (heavy averaging) to 1.000 (no
averaging).

ParameterAverage:sms = o0 X Parameterysy,s + (1 — o) x ParameterAverage; [Equation 1]
where:
ParameterAverage,sm,s = the parameter average at time “t+5ms”
a =ILAM (for Ip1, %02, A, AFR, ®, FAR) or PLAM for pressure.

These user-programmable filters range from 0.001 (heavy averaging) to 1.000

(no averaging).

ParameterAverage, = the parameter average at time “t”

The default averaging filter values are given within square parentheses in Table 1. These
values and the length of the pressure line assembly should not be modified without
consulting ECM.

¢ SKEW

SKEW allows the parameters %0,, A, AFR, @, FAR, and P (pressure) each to be modified by
a programmable transform of the form:

ParameterSkewed = M x Parameter + B [Equation 2]
where:

ParameterSkewed = %0,, A, AFR, ®, FAR, or P after being skewed.
Parameter = %0,, A, AFR, @, FAR, or P before being skewed.

M = Skewing gain. The default values for M are 1.000.

B = Skewing offset. The default values for B are 0.000.

The skewed parameters are displayed and output (i.e. analog outputs, CAN).
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CONF (Configure) Setup Option

CONEF setup appears at the end of the setup list for the lower channel. To enter CONF, press
the SYS key until “MOd” appears on the upper display, press the J key until “CONE”
appears on the bottom display, and then press the ENT key. CONF relates to display head
setup (as opposed to lambda module or sensor setup).

¢ LEdS

The display intensity is %rogrammable. Press the ENT key when “LEdS” appears on the
lower display, press the T or { keys until the display intensity is suitable, press ENT, and
press SYS to return to RUN mode.

¢ 1V4V

This feature commands a 1 V (when “1V” is on lower display) or 4 V (when “4V” is on
lower display) output on all six analog outputs. This feature is useful when troubleshooting
the interface with an external data acquisition device.

¢ CAN

Figure 4a shows cabling connected to the back of the display head for CAN communication.
Depending on where the display head appears in your CAN bus, the termination resistor may
have to be present or removed.

The CAN data communicated is:

What is being sent to analog output 1

What is being sent to analog output 2

What is being sent to analog output 3

What is being sent to analog output 4

What is being sent to analog output 5

What is being sent to analog output 6

What is being sent to the upper display (but not averaged by display)
What is being sent to the lower display (but not averaged by display)
. An error code for the upper channel. See Appendix C.

10. An error code for the lower channel. See Appendix C.

11. An auxiliary code for the upper channel.

12. An auxiliary code for the lower channel.

DO NN U R W —

It is important to note that if a parameter that is being displayed is changed (by pressing the T
or ¥ key), the CAN data will also be changed to that newly displayed parameter for 7 or 8
(above). Similarly for an analog output. LOCKing the display head can be used to avoid this
problem.
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The CAN data is broadcast at 500 kHz in the following format:

CANid | byte0 | bytel | byte2 | byte3 | byte4 | byte5 | byte6 | byte?
CIDI What is being sent to analog output 1 What is being sent to analog output 2
CID2 What is being sent to analog output 3 What is being sent to analog output 4
CID3 What is being sent to analog output 5 What is being sent to analog output 6
CID4 What is being sent to upper display What is being sent to the lower display
ERCd Error code for upper display/channel Error code for lower display/channel
Error Error Aux. Pressure | Error | Error Aux. Pressure
Code Code Code Err Code | Code | Code Code Err Code
Low High Low' Low High Low'

! For LambdaCANp modules only.

Each of the eight parameters in CIDI to CID4 is a single-precision 32 bit floating point
number that conforms to the IEEE-754 standard. All eight of these parameters are
transmitted on the CAN bus least significant byte first (Intel format). Parameters 1 through 8
(everything except error codes) sent on the CAN bus are averaged (“AVG”d, see CAL Setup
Option).

Error codes are transmitted with address ERCd. The error codes are 16 bit integers that refer
to those listed in Appendix C. The error codes are transmitted on the CAN bus least
significant byte first (Intel format). The auxiliary code is the countdown number appearing
on the channel’s display. If there is no error or active countdown, an error message is not
broadcast.

Addresses CID1 through CID4 and ERCd are user programmable. Refer to Appendix F on
how to program them and how to produce a .dbc file (which requires a PC running the
supplied Configuration Tool Software). This .dbc file can be used with programs accepting
the VectorCAN .dbc format.

The rate at which CAN data is sent can also be programmed via the “RATE” parameter under
“CAN”. To program how often the CAN data is to be sent: enter SYS mode, ¥ down to
“CONF”, press the ENT key, + down to “CAN”, press the ENT key, ¥ down to “RATE”,
press the ENT key, then enter the rate in ms. The allowable range is Sms to 9999ms with
5ms being the default.

The CAN baud rate is programmed via the “BAUd” parameter under “CAN”.
¢ LOCK

“LOCK” locks the selection of displayed parameters and instrument setup. When locked, the
display head can just be turned on and off. It cannot be modified unless unlocked. Refer to
Appendix E for more information.

¢ FACT

“FACT” (in the CONF Setup Option) resets the display head to the default setup. The
default setup is shown [in square parentheses] in Table 1. “FACT” (in the CONF Setup
Option) does not reset FUEL, pressure sensor calibration numbers N and C, averaging filters
ILAM and PLAM, nor does it cancel a user calibration of a lambda sensor. To cancel a user
calibration of a lambda sensor use “FACT” in the CAL Setup Option.
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Specifications and Limits

Measurements and Accuracies

Parameter Range Response Time Accuracy
Lambda (1) 0.4 to 25 <150ms* +0.6% (at A=1)
+0.9% (elsewhere)
AFR 6 to 364" <150 ms* +0.6% (at A=1)
+0.9% (avg. elsewhere)
Equivalence Ratio (®) 0.04 to 2.5 <150ms” +0.6% (at A=1)
+0.9% (avg. elsewhere)
FAR 27 to 1667 <150 ms* +0.6% (at A=1)
+0.9% (avg. elsewhere)
%0, -25 to 25%" <150 ms* +0.1% (absolute)
Pressure 0to 517 kPa/75 Psia <50ms° +0.25 Psia
+1.7 kPa

! AFR and FAR range given for a fuel with an H:C ratio of 1.85.
2 FAR x 10000 is displayed. This is the most commonly used way to express FAR.
For example, with an H:C=1.85 fuel, Lambda=1 is FAR=686.8.
3 For stoichiometries leaner than Lambda=1 , negative %0;s are displayed.

This convention (i.e. negative %02s) is sometimes used with engines when rich.

* The response times are affected by averaging filter ILAM (for Ip1, %0,, A, AFR, @, FAR).
See CAL Setup for more information.
> The response times are affected by averaging filter PLAM (for P).
See CAL Setup for more information.

Sensor Limits and Specifications

¢ Lambda Sensor

Exhaust Gas Temperature Range: 0 - 850 °C, 32 - 1562 °F

Maximum Exhaust Temperature: 950 °C, 1742 °F

Maximum Rate of Temperature Change: 50 °C/s, 122 °F/s

Fuel Composition:

H:C ratio range: 1.00 - 10.00, or Hydrogen (H,)
O:C ratio range: 0.00 - 10.00
N:C ratio range: 0.00 - 1.00

gasoline:

methanol: H:C=4.0, O:C=1.0, N:C=0.0

1.70 <H:C < 2.10, O:C=0.0, N:C=0.0, (1.75 or 1.85 are commonly used)
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ethanol: H:C=3.0, O:C=0.5, N:C=0.0
propane: H:C=2.67, 0:C=0.0, N:C=0.0
methane: H:C=4.0, O:C=0.0, N:C=0.0

Maximum allowable levels of fuel "Impurities":

Lead: 0.012 gm/gal., 0.003 gm/Itr.
Phosphorus: 0.0008 gm/gal., 0.00027 gm/Itr.
Sulfur: 0.035% by weight

Do not use the lambda sensor in a heavily-sooting or crankcase-oil-burning engine
because these conditions will shorten the life of the sensor.

Thread Size: 18mm x 1.5 mm. Lightly coat with non-lead containing antiseize
compound. The lambda sensor's thread size is identical to that of the
exhaust gas oxygen (EGO) sensors used in current production
automobiles with 3-way exhaust catalysts.

Hex Size: 22 mm
Tightening Torque: 40 +4 Nm, 30 £3 ft-1bf
& Pressure Sensor

Note: Must attach to engine via pressure sensor tubing only!
Do not directly attach to the exhaust or pressure sensor damage will result.

Diaphragm Material: Stainless steel

Maximum Pressure: 200 Psia, 1379 kPa (absolute)
Operating Temperature Range: -40 to 105 °C
Thread on Pressure Sensor: %4” NPT

Fitting on Pressure Sensor: Swagelok SS-400-7-4 to mate with %4 tube (USA) or
Swagelok SS-6MO-7-4 to mate with 6 mm tube (Metric)
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@ Pressure Sensor Tubing

Note: Stainless steel end of tubing towards engine. Teflon end towards pressure sensor.

Mating Thread with Engine: ¥4 NPT (USA) or %4 ISO tapered (Metric)

Tubing Assembled Length: 28 (USA) or 711 mm (Metric)

Tubing Diameter: %4” (USA) or 6mm (Metric)

Nut, Front Ferrule, Back Ferrule at Pressure Sensor end of Tubing:
Swagelok SS-402-1, SS-403-1, SS-404-1 (USA) or
Swagelok SS-6M3-1, SS-6M4-1, SS-6M2-1 (Metric)

Union between Stainless Steel and Teflon Tubing: Swagelok SS-400-6 (USA) or
Swagelok SS-6MO-6 (Metric)

Fitting on Engine End of Tubing: Swagelok SS-400-1-4, '4” tube to %4” NPT (USA) or
Swagelok SS-6MO-1-4RT, 6 mm tube to ¥4 ISO tapered (Metric)

Output Specifications

¢ Analog Outputs
Output Range (linearized in displayed units): 0 to 5 VDC, 20 mA max.

Output Impedance: 2.66 kQ

Bits Resolution: 12 bits
Update Rate: 5 ms

Isolation: Electrically isolated from power supply ground.
All analog output grounds common.

¢ CAN
Protocol: Broadcast
Rate: Programmable (5 ms default)
Speed: Programmable (500 kHz)

Isolation: Electrically isolated from power supply ground



General Specifications

& Power

DC: 11 to 28 VDC

Current Draw: 0.5 A (display), 1.2 A steady-state (per module and sensor),
On start-up, lambda sensor and module may draw as much as 4 A for 30 s.

Case Ground: The Lambda 5220 display head case is connected to power ground via a
2.15 kQresistor.

€ Key-on Signal

“ON” Voltage Level: 2.7 to 32 VDC
Current Draw: 100 uA

4 Environment
Display Head: -40 to 85 °C, 100% humidity non-condensing, display head is not sealed
Module: -55 to 125 °C, 100% humidity, module is sealed, IP67

@ Dimensions and Weight

Display Head: 108 mm x 64 mm x 178 mm, 4 /4" x 2 2" x 7", (W x Hx D)
676 gm, 24 oz

Module: 120 mm x 37 mm x 143 mm, 4 %7 x 1 2" x 5%, (W x Hx D)
244 gm, 8.7 oz
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Appendix A: 5200 Series Instruments Parts List

01 Display Heads (Just display head. Must add cables, etc.)

01-01 NOx 5210 (just head, no module, no cable, no sensor)
01-02 Lambda 5220 (just head, no module, no cable, no sensor)
01-03 EGR 5230 (just head, no module, no cable, no sensor)
01-04 dashCAN (includes cable and T)

01-05 dashCAN+ (6 analog outputs, includes cable and T)
01-06 dashCANCc (includes cable and T)

01-07 NOX/NH3 (just head, no module, no cable, no sensor)
01-08 dashCANZ2 (2 analog outputs, includes cable and T)

02 CAN Modules (just module)

02-01 LambdaCAN (just module, no sensor, no cables)

02-02 NOxCAN (for original sensor, just module, no sensor, no cables)
02-03 NOXCAN-G (for "G" sensor just module, no sensor, no cables)
02-04 LambdaCANCc (just module, no sensor, no cables)

02-05 appsCAN (just module, no cables)

02-06 baroCAN (just module, no sensors, no cables)

02-07 NOXCAN-T (for "T" sensor, just module, no sensor, no cables)
02-08 LambdaCANp (just module, no sensor, no cables)

02-09 LambdaCANd (just module, no sensor, no cables)

02-10 gpCAN (just module, no cables)

02-11 COCO2CAN (just module, no sensor, no cables)

03 Simulators, Heater

03-01 LambdaCAN Sensor Simulator (just module, no cable)
03-02 NOx Sensor Simulator (just module, no cable)

03-03 Ceramic Sensor Heater (just module, no cable)

03-04 NOxg Sensor Simulator (just module, no cable)

03-05 NOxt Sensor Simulator (just module, no cable)

03-06 LambdaCANp Sensor Simulator (just module, no cable)

04 Power Supplies

04-01 AC/DC Power Supply, Universal, 24V, 4A
04-02 Vboost Supply, 10~14VDC to 24VvDC @ 14.5A
04-03 30A AC/DC Power Supply, 24V, 100~240VAC
04-04 15A AC/DC Power Supply, 15V, 120VAC
04-05 60A AC/DC Power Supply, 15V, 120VAC

05 Linear O2 (Lambda) and CO/CO2 Sensors
05-01 NTK 6 mA

05-02 Bosch LSU4.2
05-03 Bosch LSU4.9
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05-04 NTK 4 mA

05-05 Bosch LSU4.2, Type P

05-06 Delphi OSL

05-07 NTK 4mA Cofired (ZFAS-U2)
05-08 Bosch LSUA4.9, Type P

05-09 Bosch ADV

05-10 NTK, 6mA, Type P

05-11 Bosch LSU4.2, Type PI (Intake)
05-12 CO, CO2

06 NOx and NH3 Sensors

06-01 NOx Original (use with NOxXCAN)

06-02 NOx Type "G" (use with NOxCANQ)

06-03 Calibrate NOx Sensor

06-04 Cal Sheet with NOx Sensor

06-05 NOx Type "T" (use with NOxCANTt)

06-06 NOx/NH3 Sensor (use with NOx/NH3 5240)
06-07 NH3 Sensor

07 Sensors

07-01 Pressure, 0-75 psia, 1/4", (USA)

07-02 Pressure, 0-517 kPa, 6mm, (Metric)

07-03 Pressure, Type P, 0-75 psia, 1/4", (USA)

07-04 Pressure, Type P, 0-517 kPa, 6mm, (Metric)

07-05 Pressure, Type KP, 0-75 psia, 1/4", (USA)

07-06 Pressure, Type KP, 0-517 kPa, 6mm, (Metric)

07-07 RH (Humidity) Sensor, 72" NPT

07-08 Pressure (LambdaCANp, COCO2CAN, baroCAN only), 0-75 psia, 1/4", (USA)

07-09 Pressure (LambdaCANp, COCO2CAN, baroCAN only), 0-517 kPa, 6mm, (Metric)

07-10 Pressure (LambdaCANp, COCO2CAN, baroCAN only), Type KP, 0-75 psia, 1/4", (USA)
07-11 Pressure (LambdaCANp, COCO2CAN, baroCAN only), Type KP, 0-517 kPa, 6mm, (Metric)
07-12 Pressure (baroCAN only), Type KP, 10-20 psia, ¥4”, (USA)

07-13 Pressure (baroCAN only), Type KP, 70-140 kPa, 6mm, (Metric)

08 Actuators

08-01 Ceramic Sensor Heater Mount for 05-01,05-04,05-07,05-10,05-12,06-01,06-05,06-06 Sensors
09 Eurofast Cables, Ts, Term. Resistors, Connectors

09-01 4m Eurofast 12mm Cable

09-02 2m Eurofast 12mm Cable

09-03/n "n"m, Eurofast 12mm Cable

09-03/10 10m, Eurofast 12mm Cable
09-03/20 20m, Eurofast 12mm Cable
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09-04 Flexi-Eurofast Cable, 0.3m
09-05 Eurofast "T"

09-06 Eurofast Termination Resistor
09-07 Eurofast Male Connector

09-08 8 Channel Eurofast Hub Block
09-09 Termination Resistor for Hub Block
09-10 CSM-Type Lemo Terminating Resistor

10 Sensor Cables

10-01 Module Y Cable (not LambdaCANp, COCO2CAN, baroCAN, Superseded by -21)

10-02 1m Sensor Cable, (12 term.)

10-02/25' Sensor Cable, (12 term., teflon)

10-03 2m Sensor Cable, (12 term.)

10-04 1m Pressure Cable (not LambdaCANp, COCO2CAN, baroCAN), (4 term.)

10-05 2m Pressure Cable (not LambdaCANp, COCO2CAN, baroCAN), (4 term.)
append suffix SD to cable for Teflon (Severe Duty) Version

10-09 Adapter to use P/N 05-01 with AFM1000, M1200, etc

10-12 Adapter to Pressure Sensor Wires

10-14 Adapter to use P/N 2400E-1 sensor (CPC) with LCAN

10-16 Adapter to use P/N 2400E-1S sensor (Fischer) with LCAN
10-17 Adapter to use P/N 1001A-2 (Deutsch) with LCAN
10-21 Module Y Cable (not LambdaCANp, COCO2CAN, baroCAN)

10-26 1m Humidity Cable (baroCAN), (6 term.)
10-27 2m Humidity Cable (baroCAN), (6 term.)

10-30 Module Y Cable (for baroCAN only)
10-31 1m Extension Cable for 12 terminal Deutsch
10-32 2m Extension Cable for 12 terminal Deutsch

10-34 Module Y Cable (LambdaCANp, COCO2CAN only)

10-35 1m Pressure Cable (LambdaCANp, COCO2CAN, baroCAN only), (8 term.)
10-36 2m Pressure Cable (LambdaCANp, COCO2CAN, baroCAN only), (8 term.)
10-37 3m Sensor Cable, (12 term.)

10-38 3m Pressure Cable (LambdaCANp, COCO2CAN, baroCAN only), (8 term.)
10-39 1-to-4 Pressure Sensor Adapter (for /P kits only. Not for /PB kits)

10-40 3m Pressure Cable (not LambdaCANp, COCO2CAN, baroCAN), (4 term.)
10-41 3m Humidity Cable (baroCAN), (6 term.)

27



28

10-42A 1.5m LambdaCANp Cable, Lemos at Midpoint, Controller Side
10-42B 1.5m LambdaCANp Cable, Lemos at Midpoint, Sensor Side

11 Cables

11-01 DC Power Cable, DB9F, Spades

11-02 DC Power Cable, DB9F, Banana Plugs

11-03 DB9M to CSM Lemo F Adapter (CSM Upstream)
11-04 DB9M to ETAS Lemo Adapter

11-05 Female Eurofast to DB9F

11-06 Male Eurofast to CSM Lemo F Adapter (CSM Downstream)
11-07 In-Line Power Entry Cable

11-08 2m Key-on Cable

11-09 2m Heater Cable

11-10 2m Hub Power/Eurofast Harness

11-11 Simulator (SIM300, 400, 500, 600, 700, 800) Cable

11-14 BNC to Banana Cable

11-15 DC Power Cable, Spades

11-16 DC Power Cable, Banana Plugs

11-17 Deutsch DTM3M to DB9F

11-18 3m DB9 Cable, M-F

11-19 EIB Power Tap to Ceramic Sensor Heater Controller
11-20 25' DB9 M-F Cable

11-21 SIM-200 Calibration Kit

11-22 Left (gray) appsCAN Connector with 300mm Pigtail Wires
11-23 Right (blk) appsCAN Connector with 300mm Pigtail Wires
11-24 Connector Kit: 2 connectors, 24 terminals, 12 plugs

11-25 Male Eurofast to Braided Shield Ground

11-26 Boom Box Cable for CAN Products (80' CAN, 30' Power)
11-27 Boom Box to Hub Springy Cable (1m relaxed, 2m stretched)
11-28 Male Eurofast to DBIF

11-29 Simulator Power Cable

11-30 Simulator LSU4.9 Adapter Cable

11-31 Lemo to Eurofast Adapter Cable for LambdaCANc

11-32 M-F Eurofast Panelmount Connector

11-33 1m CSM F Lemo to DB9F

11-34 1m CSM Power Lemo to Male Eurofast

11-35 Termination Resistor for in F Lemo Package
11-36 1m DC Power Cable, DB9F, Banana Plugs

12 Mounting Panels, Bosses, Probes, and Hardware

12-01 19" Rackmount Panel. Holds up to 4 Displays
12-02 18mm x 1.5mm MS Boss and SS Plug

12-03 18mm x 1.5mm SS Boss and SS Plug

12-04 18mm x 1.5mm Tall Al Boss, Cu Gasket, Al Plug
12-05 1/4" NPT MS Boss and Brass Plug, (USA)

12-06 1/4" NPT SS Boss and Brass Plug, (USA)



12-07 1/4" NPT Al Boss and Brass Plug, (USA)

12-08 Pressure Line Assembly, 1/4" dia, 19", (USA)

12-08A Pressure Line Assembly, 1/4" dia, 28" (USA)

12-09 Inconel Shield

12-10 18mm Cu Gasket

12-11 Pressure Line Assembly, 6mm dia, 483mm, (Metric)

12-11A Pressure Line Assembly, 6mm dia, 711mm (Metric)

12-12 1/4" 1SO tapered MS Boss and Brass Plug, (Metric)

12-13 1/4" 1SO tapered SS Boss and Brass Plug, (Metric)

12-14 1/4" 1SO tapered Al Boss and Brass Plug, (Metric)

12-15 15A Fuse

12-16 Bifurcated Intake Sample Probe, 8mm

12-17 Replacement Bifurcated Tube, 8mm

12-18 Aluminum Sensor Mounting Block, 18mm, (not for Type T NOx sensor)

12-19 Individual Cylinder Exhaust Probe, 18mm Sensor (USA)

12-20 Individual Cylinder Exhaust Probe, 18mm Sensor (Metric)

12-21PS Rolling Cart to Support 8 LCAN or NCANs

12-22 Sampling-Type Exhaust Probe (USA)

12-23 Sampling-Type Exhaust Probe (Metric)

12-24 Small Heated Aluminum Sensor Heater Block, 18mm, (not for Type T NOx sensor)
12-25 1/4" UNC Module Stacking Standoff

12-26 Small Aluminum Sensor Mounting Block, 18mm, (not for Type T NOx sensor)
12-27 Cu Gasket for 20mm x 1.5mm Boss and Plug

12-28 20mm x 1.5mm SS Boss and SS Plug for NGK NOx

12-29 18mm x 1.5mm (male) to 1/4" NPT (female)

12-30 Carrying Case, Medium

12-31 Aluminum Sensor Mounting Block, 20mm & 18mm, (not for Type T NOXx sensor)
12-32 Small Aluminum Sensor Mounting Block, 20mm & 18mm, (not for Type T NOXx sensor)
12-33 Pressure Line Assembly (for baroCAN), 1/4", (USA)

12-34 Pressure Line Assembly (for baroCAN), 6mm, (Metric)

12-35 Carrying Case for SIM300

12-36 Carrying Case for SIM400

12-37 Carrying Case for SIM500

12-38 Carrying Case for SIM600

12-39 Carrying Case for SIM700

12-40 Individual Cylinder Exhaust Probe, 20mm Sensor (USA)

12-41 Individual Cylinder Exhaust Probe, 20mm Sensor (Metric)

12-42 Aluminum Mounting Plate for 8-ch Block and Modules

12-43 Carrying Case for SIM800

12-44 Multi-Channel Cart

12-45 Sample Line Kit, 74" dia, 1.3m

12-46 Sample Line Kit, 6mm dia, 1.3m

12-47 remoteSAMPLER, append suffix /P to Part Number for P-compensation Option
12-48 External Mounting Block, append suffix /P to Part Number for P-compensation Option
12-49 Aluminum Sensor Mounting Block for Type T NOx sensor

12-50 18mm Crush Gasket
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13 Software, CAN Adapters, and Manuals

13-01 5200 Series Manuals and Config Software (CD)
13-02 Kvaser Leaf Light CAN Adapter
13-Product Name (Manual)

14 Tools

14-01 18mm x 1.5mm Tap

14-02 18mm x 1.5mm Die

14-03 72" NPT Tap

14-04 /4" 1SO Tapered Tap

14-05 Antiseize

14-06 Metal Brush to clean sensor threads
14-07 Lambda Sensor Calibration System
14-08 20mm x 1.5mm Bottoming Tap
14-09 Filler Bottle

14-10 Cupric Sulfate (3gm to add to 150cc of water)
14-11 NOx/NH3 5240 Calibration Kit



Appendix B: Module EIB Mode and Stand-alone Mode

LambdaCAN* modules can be used in conjunction with an analyzer (EIB mode) or on its
own (Stand-alone mode). When used as part of an analyzer (ex. Lambda 5220, EGR 5230),
the module is setup in EIB mode. When delivered to be used alone, the module is setup in
Stand-alone mode.

In EIB mode, the module communicates to the display head of an analyzer via a special high-
speed communication protocol. The module must be EIB mode when on the EIB with a
display head. When in Stand-alone Mode, the module communicates via the common 500
kHz CAN broadcast protocol. This is the default rate and it is programmable.

The module must be properly configured in EIB mode or Stand-alone mode depending on
how it will be used.

To convert from one mode to the other requires software reprogramming of the lambda
module followed by the removal (set to EIB) or installation (set to Stand-alone) of a jumper
inside the module.

¢ To convert a module from Stand-alone to EIB Mode

1. Connect the lambda module to a power supply and a PC via a supported USB-to-
CAN communication adapter (Kvaser, ETAS, Peak VectorCAN CAN adapter card)
using the cabling shown below. A sensor does not have to be connected to the
module. Note that only one module is connected and the display head is not involved.

Lambda Module P/N 11-02, DC Power Cable,

Serial Number DBYF, Banana Plugs (shown), or To power

P/N 11-01, DC Power Cable,
DB9F, Spades

SINPOW ‘O / BPquIET] USdONYD
Nvoepawel NDI

II “T”

5\ Resistor  /

Figure B1: LambdaCAN Module prepared for Reprogramming

To CAN adapter
on PC

31




32

2. Start the Configuration Tool

(software).

Click on the

Select the CAN adapter being used. Then start the communication.

B3 ECM Configration Tool
[% I Displaw Headl

Select CAN Adapter: |KVASER =

Configuration

Prod# Fev# Seralf ModelD  SensorS/M

EE®

Configuration Tool V2.7

START | Gratus: |Port Closed E
Tools

Generate .dbc

Device: |

Task: hd

Communication Interface

TX Type

CAWID O 1 2 3 4 § 6

=
Set to EIB Mode
Set to Stand-alone Mode:
Mate: “Set to EIB Mode™ and "Set

ta Stand-alone Mode'' can only be
used with one module on the bus

N

= = T T T T Teem
.3 I Y Y
| “alues are in hexadecimal format |

Iilao[:elD TPDO1 [ TPDOZ [ TPDO3 [ TPDO4 [

\ = \ = | = | =
’E"i ’AL jo jo jo jo
CAMapen State ‘ j ‘ j | j | j

[0 [0 [o [o

www.ecm-co.com « 408-734-3433 « Los Altos, CA, USA - (c) 2006

3. Click on the “Set to EIB Mode”. Wait for “Done” Message.

Stop communication and exit program.

ez ECM Conmysration Tool

ECM

Module ] Display Head]

Select CAM Adapter: |[KVASER =

Configuration

Prod#t Revf Seralft ModelD Sensor /M

=]

Configuration Tool V2.7

ST0P | State [Port Dpened E
Taals

Generate .dbc

Device: |[Ix[|3 0x05  OxFFFF  0x01

Task: hd

Communication Interface:

0:90F1(37105) ~|

ottt EB Fode b

- 3
Set to Stand-alone Mode

Note: “Set to EIB Mode™ and "Set
ta Stand-alons Mode'" can only be
used with one module on the bus

T Type CeNID O 1 2 3 4 5 B 7 [=|
= =TT T T rrrr e
- IR T I

L Values are in hexadecimal format |
Data
Node D TPDOT ¥ TPDO2 ™ TPDO3 ™ TPDO4 [~
Bt nox - [er +] [rrvs = s =
Enor  fus

39,15 0 [ [
’m W ‘ ppm | ma | ahms | W
CoMopenStsta |02 | [Pz ] [viem =] [vez =]
005 23362 % i w0 v o v

www.ecm-co.com » 408-734-3433 - Los Altos, CA, USA - (c) 2006

“Module”

tab.



4. Take the nut off the end of the module. Use an 18mm socket without the wrench.

6. Slide the PCB out. Remove the jumper from JP4. You can hang it on one pin of JP4
when “off”.

JP4
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7. Make sure both O-rings are on the threaded connector.

=
S
3
=
=
i

8. Slide the PCB into the enclosure until the two tangs “click”.

9. Put the nut on and tighten ONLY ! turn from where it is seated. If this nut is
tightened too much, the connector will crack and the enclosure will not be sealed.

10. The lambda module is now in EIB mode and can be on the EIB with a display.

¢ To convert a module from EIB to Stand-alone Mode

The process is similar to the previously-described procedure. Note that in EIB mode, the
module will not show up in the device list of the Configuration Tool.

1. Use the Configuration Tool (software) to “Set to Stand-alone Mode”.
2. Install the jumper on JP4 in the lambda module.

3. In Stand-alone Mode, the module will continuously broadcast data via 500 kHz CAN

(programmable). For more information, refer to the LambdaCAN Module Instruction
Manual.
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Appendix C: Error Codes and Troubleshooting

If one of the Lambda 5220°s displays flashes “ERR” followed by “####” (the Error Code), an
error has been detected in that channel’s module (or attached sensors). The below table lists
the errors. The errors are also flashed on the module’s LED.

Error

Code Module LED Action Description of Error

0000 Green ON All OK, (green LED constantly on)

0001 Flashing Green 10hz Sensor warm-up period

0002 Green/Both/Red 2s Power on reset / Init hardware

0011 Pulse Red 1x/2s 16 bit ADC failed to init. Internal module error. Contact ECM.

0012 Pulse Red 1x/2s +Vsw shorted. Internal module error. Contact ECM.

0013 Red ON A sensor turned off (red LED constantly on)

0014 Pulse Red 1x/2s A sensor heater open. A or Pressure sensor not connected.

0015 Pulse Red 1x/2s A sensor heater shorted. Bad A cable or sensor.

0021 Pulse Red 2x/2s Memory chip in A sensor’s bus shorted. Bad A cable or sensor.

0022 Pulse Red 2x/2s No memory chip in A sensor detected. Bad A cable or sensor.

0023 Pulse Red 2x/2s CRC16 error. Bad A cable or sensor.

0024 Pulse Red 2x/2s Invalid A sensor memory chip parameter. Wrong sensor.

0025 Pulse Red 2x/2s Non-compatible A sensor memory chip format (old Rev.)

0031 Pulse Red 3x/2s Vsw < 5.6 for > 7 sec. Supply voltage too low.

0032 Pulse Red 3x/2s Vsw > 30 V. Supply voltage too high.

0041 Pulse Red 4x/2s VS too high. Bad A cable or sensor.

0051 Pulse Red 5x/2s RPVS too high. Sensor too cold, bad, or battery voltage too low.

0052 Pulse Red 5x/2s (VH Commanded — VH Measured) > 0.5 V for > 10 sec.
Battery voltage too low

0061 Pulse Red 6x/2s VP+>6 V. Bad A cable or cracked sensor (common).

0062 Pulse Red 6x/2s VP+ <2 V. Bad A cable or cracked sensor (common).

0064 Pulse Red 6x/2s 0.25 V>VS+>0.75 V. Bad A sensor.

0065 Pulse Red 6x/2s

User data (span) in A sensor memory chip corrupted.

User must reperform A sensor span.

The two most common problems

Three other displays of interest are:

which means that a lambda module has not been assigned to that channel.
See MOd Setup Option.
---“ which means that the display head has an internal problem.

1.

2.
3.

13 2

13

are a damaged lambda sensor and a low supply voltage
(less than 11 V). When the sensor is damaged, it must be replaced. It cannot be repaired.

“XXXX” which means that the display is not receiving any data. The lambda module
1s disconnected, dead, or the EIB cable is broken.
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Appendix D: Calculating the %0, in Air

The Configuration Tool Software has a routine to calculate the %0, in air. If the software is
not available, the below may be used.

The oxygen concentration in dry air (zero humidity) is 20.945 and decreases with increasing
humidity. The %O, in air can be calculated from the barometric pressure (Py, in mmHg), the
relative humidity (Rh), and the saturated water vapor pressure (Pys, in mmHg) by using the

following formula:

%0, = 20.945% x (Py - Pys x (Rh/100)) / Py,

The saturated water vapor pressure (Pys) is a function of the ambient temperature (T,) and is
given in the table below. For example, at 21 °C, Py = 18.65 mmHg.

Ta 0 1 2 3 4 5 6 7 8 9
(°C)
Pws (Mm Hg)

0 4579 ] 4926 5294] 5685] 6.101| 6543 7.013] 7.513[ 8.045] 8.609
10 9.209 9.844 | 10518 | 11.231 | 11.987 | 12.788 | 13.634 | 14.530 | 15.477 | 16.477
20 17.535 | 18.650 | 19.827 | 21.068 | 22.377 | 23.756 | 25.209 | 26.739 | 28.349 | 30.043
30 | 31.824 | 33.695 | 35.663 | 37.729 | 39.898 | 42.175 | 44.563 | 47.067 | 49.692 | 52.442
40 | 55.324| 5834 6150 64.8| 68.26| 71.88| 75.65| 79.60| 83.71| 88.02
50 92.51 97.2 | 102.09 | 107.2 | 112.51 [ 118.04 | 123.80 | 129.82 | 136.08 | 142.60
60 149.38 | 156.43 | 163.77 | 171.38 | 179.31 | 187.54 | 196.09 | 204.96 | 214.17 | 223.73
70 233.7| 2439 | 2546 | 2657 | 2772 2891 | 3014 3141| 327.3| 3410
80 355.1| 369.7| 384.9| 400.6| 416.8| 4336 | 450.9| 468.7| 487.1| 506.1
90 | 525.76 | 546.05 | 566.99 | 588.60 | 610.90 | 633.9 | 657.62 | 682.07 | 707.27 | 733.24

I mmHg = 0.01934 Ibf/in2 = 1 torr = 133.32 N/m2

1 atm = 14.696 1bf/in2 = 760 torr = 101325 N/m2
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Appendix E: LOCKing and unLLOCKing Display Head

When the display head is locked, the parameters displayed and instrument setup cannot be
modified. The display head can just be turned on and off.

@ To LOCK the display head

Press SYS until “MOd” is displayed.
Press { until “CONF” is displayed. Then press ENT.
Press { until “CLOCK” is displayed. Then press ENT.

“50” will be displayed. Press T until “60” is displayed. Then press ENT.
Display is now LOCKed.

b=

@ To unLOCK the display head

1. Press SYS until “LOCK” is displayed. Then press ENT.

2. “50” will be displayed. Press T until “60” is displayed. Then press ENT.
Display is now unLOCKed.

If an unauthorized person learns that 60 is the key number, contact ECM.
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Appendix F: Using the Configuration Tool Software

ECM’s Configuration Tool runs on a PC and is for use with ECM’s analyzers and modules.
The Configuration Tool is supplied on a CD with each analyzer and module and is available
for download on www.ecm-co.com.

The Configuration Tool can be used for the following:

1. To produce a .dbc file for one or more analyzers on the same CAN bus.

2. Real-time display of data from analyzers. Only one analyzer’s data is shown at a
time.

3. Log data from one or more analyzers.

To connect a PC to the CAN connector on the back of an analyzer requires the supplied
cables (see Figure 2) and a USB-to-CAN adapter. Make sure the CAN bus is properly
terminated. The following adapters are supported: Kvaser, ETAS, Peak USB to CAN
adapters, and the VectorCAN CAN adapter card. Driver software for one of these adapters
must be installed prior to using the Configuration Tool. Driver software will be supplied
with the adapter or be available on-line.

Once the analyzer(s) are connected to the CAN bus and turned on, leave “Exclusive”
checked, start the Configuration Tool, select the “Analyzers” tab, select the CAN Adapter,
leave “Exclusive” checked, and then press the start button. “Status:” should change to “Port
Opened”.

@ Producing a .dbc File

Devices receiving CAN messages from one or more analyzers must understand the format of
the messages. A .dbc file is used to describe the format. Using the Configuration Tool, a
.dbc file describing the format of messages from one or more analyzers on the same CAN bus
can be created.

Each analyzer communicates eight pieces of data, two error codes, and two auxiliary codes.
The eight pieces of data are: what is being sent to the six analog outputs and what is sent to
the upper and lower displays. Before producing a .dbc file for the analyzer(s), each analyzer
on the CAN bus should have its displays and analog outputs programmed for the desired
data. It is important to note that if a parameter that is being displayed is changed (by pressing
the T or { key), the CAN data will also be changed to that newly displayed parameter.
Similarly for an analog output. LOCKing the display head can be used to avoid this problem.

Once the analyzer(s) have been programmed, send (one analyzer at a time) each analyzer’s
message format to the Configuration Tool.
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To do this:

b

1. In the software, press “Add Device”. A “Waiting for Analyzer...” window will

appear. Leave it open.

2. On an analyzer, press SYS, arrow down to CONF, press ENT, arrow down to CAN,
press ENT, and with “IdS” on the display, press ENT.

Five CAN ids need to be entered: one each for CID1, CID2, CID3, CID4, and ERCd.
These are entered in decimals. The allowable range is 1 to 2047. If analyzers and
modules are on the same CAN bus (not EIB bus), be careful to avoid using the CAN
ids used by the modules. The CAN ids used by the modules are: 0x00, 0x80 +
Module NID, 0x180 + NID, 0x280 + NID, 0x380 + NID, 0x480 + NID, 0x580 +
NID, 0x600 + NID, 0x700 + NID, 0x7E4, and 0x7E5. Note that these module CAN
ids are given in hex. CID1 is the CAN id for the data going to analog outputs 1 and 2.
CID2 is for analog outputs 3 and 4. CID3 is for analog outputs 5 and 6. CID4 is for
the upper and lower displays. ERCd is for the error codes and auxiliary codes. After
entering the CAN id for ERCd, “.dBC” will appear on the display. Press ENT, you’ll
get some “spinning wheels” on the analyzer and the format of the messages for that
analyzer will be sent to the Configuration Tool.

3. Each analyzer’s serial number will appear in the “Device:” window list (open window
to see all present) after its message format has been received by the Configuration
Tool. When an analyzer’s serial number is in the “Device:” window, its data will
appear at the bottom of the Configuration Tool’s screen.

4. After the last analyzer on the CAN bus has sent its message format to the
Configuration Tool, that list of analyzers can be saved using “Save List” and later
recalled using “Load List”. This saves having to resend message formats to the
Configuration Tool next time the tool is used.

5. A .dbc file for all analyzers in the “Device:” window list is produced by pressing
“Generate .dbc”.

6. The analog parameters are called A# sn where “#” is the analog output number and
“sn” is the serial number of the display head (ex. A1 _45405300). The serial number
is the first thing that is displayed on startup on the display head. The display
parameters are called TopDisp sn, and BtmDisp sn. The error codes are called
TopErr_sn, TopAux_sn, BtmErr sn, and BtmAux sn. During O, sensor warm-up
when the display is counting down, TopAux sn or BtmAux sn will contain the
countdown number.

@ Real-Time Display

When an analyzer’s serial number is in the “Device:” window, its data will appear at the
bottom of the Configuration Tool’s screen.
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@ Logging Data

Analyzers whose serial numbers are in the “Device:” window list can be data logged. Press
the “Log Data” button and follow the instructions. Data is saved in .csv format.
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Appendix G: Setting Up ETAS INCA for ECM Modules

Hardware Setup: Using ETAS ES591.1

1. Connect the power port to a power source between 6V and 32V.

2. Connect the Ethernet port directly to the Ethernet port on your PC. This port does not
use an internet/intranet connection like a router.

3. Connect either the CAN1 or CAN2 port to a CAN network (i.e. ECM analyzer(s)
and/or module(s)).

Software Setup: Using ETAS INCA V5.4.1, Hotfix 22, GM Install
1. Double click the INCA V5.4 icon to open the software.

2. Create a new Database. In the Database menu, select New. Give your database a
name (i.e. a folder name). In INCA, a Database means the current working directory.
Each project is created in a unique directory. When INCA is opened, it will default to
the last Database that was used.

3. Add a new Workspace. Right click on the “DEFAULT” folder icon, select Add >
Workspace. You can rename it to whatever you want.

- INCA V5.4.1/22

Database Edit Yiew Options Utilities 7
D= E Xl - 0 HRERE D Y

1 Items

m Add 3 Add top Folder
Add Folder Insert
Delete Delete Experiment Chrl+T
c Chrlc ECU-Project (aZ()... Crl+P
apy ! COM-Configuration Alt+C
Measure-Catalog. ..
Rename Fz ECU Documentation, ..
Can-DE...
I List of CAN Messages
Import Ctrl+ Read CAMN Message Log File. ..
Expork Chrl+E
Write: 3
Convert Experiment 3

4. Add a new dbc file for your project. Right click on the workspace you created in
step 3, select Add > Can-DB. Browse to your dbc file and click open. Appendix F
describes how to produce this .dbc file. In this example, we are using a file named
test8mod.dbc. An INCA log window will pop up. You can ignore this.
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3 INCA V5.4.1/22

Database Edit  Wiew Options Utilities Experiment Project Device 7

D= E & By X (B8 R ESRNEIN 5 m__
IHCA
Lo " INCA V5.4.1/22*
[l {ZdDEFALLT Database Edit Yiew Options  Utilities
T S 1o o = 3 g
A £ . 2
Add Folder Insett D L= E ':"% x "& |
Workspace Chriw 1 Items
Delete Delete Experiment Chrl+T —
E”t E:r::z ECU-Project (A2D. . Crlep =l {ADEFAULT
=Py ! CDM-Configuration Al+C — od
- L4
Measure Catalog.... T Workspace
Rename Fz ECU Documentation, .,
Edit Return
| List of CAN Messages
Lmport Cerk Read CAN Message Log File. ..
Export Chrl+E
Wrike 3
Convert Experiment »

5. Configure the hardware. Click on the icon for the workspace you created in step 3.
Open the Hardware Configuration icon under the section text “6. Hardware”. A
hardware configuration window will open.

IHCA

w INCA V5.4.1/22*

Database Edit  MWiew Options Utilities Experiment Project Device 7

OE $#BEX i@~ &8 SR80 8 vl
1 Ikems 4 Expetiment

=1 ‘I DEFALLT Al 88X

I: B ct5mod |

S Project/device

=19

u

=

[ Hardware/

Workspace L

3 Item comment Caonfigure hardware

(4/1/2006 3:27:24 PM 528 55

|

Filter: none | DB: <test: User: <MainUser >




6. Select the hardware. In the hardware configuration window, right click the “HWK
Workspace” listed under the section text “1. Hardware Devices”, and select Insert.
Select the ETAS device you wish to use. In this example, we are using an ETAS
ES591.1. Expand the selection tree by clicking the “+” next to the hardware device
model. Expand the CAN selection and select CAN-Monitoring. Click OK.

. Hardware: >Workspace= Experiment: >Default<

File Hardware Device Channels Yiew 7

HOT B | e o
3E Add| handware device

Select the new modules you want to add to
the hardware configuration. —
Avvailable HY devices Cancel |

= & ES600/ESSI0/ESS1 Multiglcity
—E= T can {Inactive)

I

1 Hardware devices
Hwi Workspace

|2

CAN-Monitaring;
= amLan

2 can-output
fucp

cce W
= kwipz000

E=Fups

—E Ek-Line...

EheTrC

LR o T T

<

7. Associate the dbc. When you clicked OK in the last step, another window will pop
up that will allow you to select a dbc that you have added to your workspace from
step 4. Expand the selection tree, select your dbc file, and click OK.

—./Hardware: >Workspace< Experiment: >Default<

File Hardware Device Channels Yiew 7

MO E A8 O e

Select project and working data for CAN-Monitoring:1

1 Hardware devices

HWE Workspace i
I?_ 555991555904’5%591’1 1 Items add ||| 41nfo —
SN: Mok assignes — = — QK
L% CAN:L =] {ZDEFALLT ~ ;l -
@CAN—Monitoring:l L =, bestEmod -
Cancel | sty e

€

Fnent F

|Can_DB... - kestamod

3 Ikem comment
(4/1/2005 3:36:10 PM 937 63)
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8.

Initialize hardware. The hardware is currently stopped, as indicated by the red stop
sign icon next to the selected hardware. You must initialize it before you can use it to
collect data. Click on the Initialize Hardware button on the upper tool bar and wait
for the hardware to complete its initialization. Another window will pop up to
confirm the device to connect to. Click OK.

—'IHardware: >Workspace= Experiment: =D

i’ Connect devices...

Systems

INCA Hardware Configuration Detected Hardware e} Connected ]

File Hardware Device Channels Wiew ?
#o = J4dE B
1 Hard .

MOTRSpECE

ES690/ESS90/ESS21:1
SM: Mot assigned

I— CAM:

Cr-Manitaring: 1

Filter

Ho:

@ all connect

Type:
ESEO0[ESSO0/ESSI1: L
SN: Not assigned SM: 120411

o

Info | .
stirterfaceType System type

ted

9.

Open an Experiment Environment. Click on the Experiment Environment button
on the upper tool bar to open an Experiment Environment. The Experiment
Environment is where you can setup the monitoring of the CAN bus. By default, the
Experiment Environment will be blank. You must select the variables from the dbc
file that you wish to monitor. Click on the Select Variables icon in the left hand tool
bar of the Experiment Environment.

Experiment: >Mew experi

Expetiment View Yariables Mea:

O

=

—'Hardware: >Workspace= Experiment: >Default< @

File Hardware Device Channels Wew ¥ B

MO = AdE )5 W

1 Hardware devices ,{fxperiment environmenk CtrI+F5| -

HWE Workspace ]

li ESER0/ESS20/ESS21:1 x
I?_SN: 120411 Select variables...  Shift+F4

CAM:L Bic]

€ Can-Manitoring: 1 =




10. Select and Configure Variables. Select the variables that you wish to monitor in the
Experiment Environment. These variables names are based on the data found in the
dbc file. Click Configure.

" Select variables =Measure variables >

Filtet ‘“ariables Selected 7

1 Devices E 3 Yariables 4 Selected already used
= B O caM-Maritaring:1 A || |?E0 AFR_0xD1  {TPDOZ_OxD1-FF AFR_0x01
—— B2 O Emergency_0x01 ¢ 0 cCaMopen_Error_Code_0x01  {Emergency_0x01-F- CAMopen_Error_Code_0z01
—— B= O Emergency_oxoz €0 Canopen_Error_Reg_Ox01  {Emergency_0x01-F CANopen_Error_Reg_0x01
— B2 O Emergency_0x03 * 0 CaNopenState_0x01  {Heartheat_Ox01-F} CANopenstate_0x01
—— B2 0 Emergency_0x10 €0 ECM_awsliary_0x01  {Emergency_0x01-F- ECM_Auliary_0x01
—— B= O Emergency_oxz0 €0 ECM_Error_Code_0x01 {Emergency_Owol-fr ECM_Etror_Code_0x01
— B2 O Emergency_0x21 B0 FAR_OxDL  {TPDOZ_Ox01-f} FAR_0x01
—— P20 Emergency_0x22 "0 LAM_0x0L  {TPDO1_(0x01-f} LAM_Do
—— B= O Emergency_0x23 B0 0zZ_0x01 {TPDO1_Dx01-fr ©z_0x01
— Eg O Heartbeat_0x01
— Eg O  Heartbeat_0x02
— Eg O Heartbeat_0x03
—— B O Heartbeat_0x10
— Eg O  Heartbeat_0x20
— B2 O Heartbeat 0xz1 ™

Mo raster pre-selection possible!

Configure | Use defaults | Cancel

11. Another window will pop up to configure each selected variable. You can configure,
for each variable, whether to record or simply display the data, how the data will be
displayed (graphs, charts, gauges, numeric, etc.). When complete, click OK. We
have left all configurations at default for this example.

i Configure Selected Yariables |zl@@

Components  Filker  Parameters

2 Parameters

Parameter I
Mame Stabe dT =7 ‘window Display type Device
AFR_0x01 Dispfrac = .layer_l>><Meas. > Murn ZAM-Monitoring: 1
CAMopen_Error_Code Dispfrec = .layer_l=><Meas. > Murn ZAM-Monitoring: 1
CAMopen_Error_Req. Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
CAMopenState_0x01 Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
ECM_Auxiliary_0x01  Dispfrec = .layer_l>=<Meas.> Mum CAN-Monitoring: 1
ECM_Errar_tCode_0x( Disp/rec = .layer_l>=<Meas.> Mum CAN-Monitoring: 1
FAR_Ox01 Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
LaM_0x01 Dispfrec = .layer_lz=<Meas.> Mum CAN-Monitoring: 1
0Z_0x01 Disp/rec = .layer_l>r=Meas.> ’—L| CAN-Monitoring: 1

Active Component: <Experiment:=  |Active Filter: <all Types= |Active Parameter: <OZ_0x01=

QK Cancel

12. A new sub-window will be added to the Experiment Environment. You do not need
to select all the variables you want to monitor all at once. You can click on the Select
Variables icon again at a later time to add more variables. Each set of variables you
add will be placed in a new sub-window unless it is configured to join an existing
sub-window. In this example, we have created a sub-window for each of the eight
modules in the dbc file.
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Experiment: >NewExp= Hardware: >Workspace<

Experiment Yiew Varjables Measurement Hardware Dataset Components tindow 2

D | re—" B[] 2] Measure window [+ 8| |8 Measure windo =
z 02_0x01 [ - 126 Q2R _0x10 I - [ 126] O2_0x22 ] - 13%]
— | AFR_Dn01 I -In CAMopen_Error_Reg_0x10 | [thex) | AFR_Dx22 ] -lo
g CAMopen_Error_Code_0x01 H -H[hex] CANDpen_Errcr_Code_DxWD[l -ﬂ[hex] CANDpen_Errcr_Code_Dx22|l —H[hex]
; CANopen_Error_Reg_0x01 H = H [hex] CAMNopenState_0x10 [l -|| [hex] CAMopen_Error_Reg_0x22 || —H [hex]
. | SANorenstate o1 | -lihed | ECM_Awdliary_0x10 [ -|ihed | CANopenState_0xz2 I - thex
| Eoh Adliany Dl | “|ihed | ECM Error_Code_0x10 [ Jihed | ECM_Ausdliary_0x22 I - thex
3: ECM_Error_Code_ 0w | Jiheq fiP1_oxi0 [ |ima] | ECM Error_Cods_0x22 I - thex
mm | FAR_0:01 | o P2 010 [ [ wal FAR_ =22 I o
o llLani o [ o WO _0x10 I Jippm) [fLar mx22 I B [
y L do | %] Measure windo =] =] Measure window [3 =)
e | O2_0x02 I - 12%] 0z_0x20 I - 12] AFR_0x23 I -|n
Il | AFR D2 | -To AFR_ 0520 [ -To CARNopen_Error_Code_0x23 | -|thex
2] CAMNopen_Error_Code_0x02 H fﬂ[hex] CAMopen_Error_Code_0x20 [l fﬂ[hex] CAMopen_Error_Reg_0x23 |] ﬂ[hex]
g CAMNopen_Error_Reg_0x02 H = H [hex] CAMopen_Error_Reg_0x20 [l = H [hex] CAMNopenState_[x23 |] || [hex]
g | SAnepenSiate 0x02 | “Jihexd | CANopenState_0x20 [ Jihex) | ECM Ausiliary_0x23 [ | thex
7 | ECM_Awidliary_0x02 | Jiheq | ECM Ausiliary_0x20 [ ~|lhex) | ECM Error_Code 0x23 [ | ihe
ECM_Error_Code_0x12 [ -|ihexg | ECM_Errer_Ceds_0x20 [ e | FAR_0x23 [ o
FAR_0x02 I -Io FAR_0x20 I -Io LAM_0x23 I -Io
LAK_ 02 I -1n [N[Car oo I -1n 02_0x23 I BES
= asure do O | Measure dow [6 m|
Q2R_0x03 | - [z] 02_0x21 - [24]

CaMeopen_Error_Cede_0x03 |I - [hex] AFR_Ox21
- | [hex] CAMopen_Error_Code_0x21
- | [hex] CAMopen_Error_Reg_0x21

[ l [
[ l [
[ l [
[ I [
= H [hesd CaAMlopenState_x21 || —H [hex]
[ l [
[ l [
[ | [
[ | [

CAMNopen_Error_Reg_0x03 ||
CANopenState_0=03 ||
ECM_Ausdliany_0x03 ]
ECGM_Error_Gode_013 ]
l
l
I

-| [hex] ECM_Awuxiliary 0x21

- | [mA] ECM Error_Code_0x21
1P2_0x03 sl FEaR o

MO 0x03 - [pprr] LA 0x21

) |Measurement stopped Maz. buffer level: 0%

1P1_0x03

13. Start CAN monitoring. Right now there is no data displayed. That is because the
CAN monitoring is stopped. To begin CAN monitoring, click on the Start
Visualization icon (blue triangle) on the left hand tool bar. To stop CAN monitoring,
click the Stop Measuring icon (black square) on the left hand tool bar. To begin
recording the data, click on the Start Recording icon (red circle) on the left hand tool
bar.

e | 02 Ox02

I | AFR_0x0Z




Appendix H: Setting Up ATI Vision for ECM Modules

NOTE: While shown here for a single LambdaCAN* module, the same procedure applies for any of
ECM’s CAN-based devices (i.e. Analyzers or Modules) as well as for multiple device simultaneously
connected on the same bus.

Introduction

Connecting ECM LambdaCAN hardware to ATl VISION software is simple and does not require any
third-party software interface. Using the ECM Configuration Tool software to produce a .dbc database
file, and the ATI VISION CANMonitor interface, any available hardware CAN interface can be used to
read LambdaCAN data.

Hardware Setup

A typical hardware configuration is shown in Figure 1. In this example, a Kvaser Leaf Light CAN-USB
adapter is used. Other supported adapters have a similar procedure. Connect the DB9 CAN connector
of the LambdaCAN to the PC to CAN adapter. Supply 11-28V DC (5A min. supply) to the
LambdaCAN. For the case of an ECM analyzer (ex. Lambda 5220), connect to CAN port on display
head. Do not directly connector to modules.

PC with PCto CAN DB9 Connector
ATI VISION Adapter

and ECM UsB ( .
Configuration L Kvaser Leaf Light

Tool L
Termination
/ Resistor
—1
DC Power Supply
11-28V
|
[ ]
Software

e ATIVISION 3.6.2
e ECM Configuration Tool v4.13

Figure 1: Equipment Schematic Layout

47



Creating a .dbc File

The ECM Configuration Tool is used to create a .dbc database file for describing the CAN
messages broadcast from an analyzer or module. All ECM products with a CAN interface use
the CANopen protocol at 500kHz by default. To generate a .dbc file from an analyzer, refer
to Appendix F. To generate a .dbc file for a module (ex. LambdaCAN module):

1. Connect hardware as shown in Figure 1. Ensure LambdaCAN bi-color LED indicator
near sensor connector is visible (green during normal operation, flashing red without
sensor attached).

2. Run ECM Configuration Tool software, and select the Modules tab (or the Analyzers

tab if connecting to 5200 series analyzers).

Select CAN adapter from drop down menus as shown in Figure 2, and click START.

4. After LambdaCAN module(s) have initialized, select desired parameters to transmit
from the TPDO drop down menus for each module.

5. Click Generate .dbc, and save this file in a location such as the VISION Projects
folder.

6. Click STOP to end CAN connection.

w

NOTE: Whenever TPDO’s are modified, a new .dbc file must be created.
ECM Configuration Tool || ECM Configuration Tool

Modules ] Analyzers] Firmware: Upgrade] Toggle W arnings [Mow: OFf] Modules ]Analyzels] Firmware Upgrade ] Toggle Wamings [Mow: OFf]

CAN Adapter. [Kuvaser ~|[Leaflign v oichel | [500Kbpsletl ] [iETARTY Status: [l CAN Adapler: [vaser ~|[CeaflightHs 0ichn) < |[500<bpsistd =] STOP | Status: [l

Configuration Toals Caonfiguration Toals
NID  Prod#) Rev.H Serialt ECH Bus Load Log Qfata [0 | NID  Prod# Rev# Serialt ECH ad Log D ata [0 ‘

Module: | || | [z 0ms Gonsio o || Do Werua Module: [010 002 OW0E (k034D v | [1B% BB fns Eol User Mol
Task: | / =] TotolBus Load ManuaIComr’ Set CAN Baud Task | Change Node ID 1| rota Bus Load Manual Comm. | Set CAN Baud

[0%2. 0 ps Colo, %02 inp, w [19%. 824 fps Calo. %02 n Ai

Set

Set Module Mode Flange: 001 - Ok7F Set Module Mods

EIB | Stand-tlone ‘ ECM recommends labeling the madule with the new MID. EIB | Stand-dlone

Mate: This function can only be The following CAN 1D are used for each module: Nate: This function can only be
used with one module on the bus. = used with one module on the bus.

Diata for Nade [D: M A& Diata for Nade |D: 0«10 TPDO: Data transmitted by module
Sensor S/H TPDOT [ TPDOZ [ TPDOZ [ TFDO4 [ Sensor 57N TPDO1 W TPDOZ v TPDOZ v TFDO4 v
S I s B S B GoaMOSEE U <] [ <] [poa <] [mee <]

o [0 [0 [0 Eio [ [325409 N CE ohrns

0x00  |0x00
Eror P CO State | j | j | j | j CO State |02 j |FAH j |”:"I>< j

[o [o o o n'a  |0x05  |20.954 % |0.307305 |6.oot1s  mA

wWWww.ecm-co.com * 408-734-3433 « Los Altos, CA, USA = {¢) 2011 WWW.ecm-co.com « 408-734-3433 « Los Altos, CA, USA = (¢} 2011

Figure 2: ECM Configuration Tool
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Setup CANMonitor using ATI VISION

ATI VISION CANMonitor provides a method of reading general purpose information from any
available CAN channel. The .dbc file generated by the ECM Configuration Tool is used to describe the
format of the information available to VVISION. To setup a CANMonitor in ATI VISION:

1. Run ATI VISION and open an existing Project File or create a new one by clicking File >
New -> Project File. In this example the Project has been named CANMonitorProject.

File View Tools Window Help - -
[ project File
= Open... Ctrl+O .EEMX configuration File
ﬁ Calibration File
[ kaM Data File

54 Import and Export... Ctrl+Q

Recent Projects [Escreen File

£ ASCIT Text File

Recent Screens
@RTF Document File

Recent Files

Exit

Description
IVV'ISION project settings and device configuration

list.

E e SR )

ile Edit View Project | Device Tools Window Help ~FR5-232 Serial Port
e : & UsB Port
= -s =] ﬁ & ):'dd Device... F5 B5TCR/IP Port

= Rermove LF POMCIA Port
Brciport

=3 Properties =3 SPvirtual CAN Channels
S2PC Based CAN Channels

Context Menu ] specifications

Description
IVPC Based CAN Channels on this computer.
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3. Add a physical hardware device by clicking Device = Add Device, and select Kvaser CAN

Channel.

H@ File Edit View Project

Device Tools Window Help

[0z e @@= o SEETENNEN

=4 Remove Device

&5 Properties F&

Context Menu

i H D
Select Device Type -

P Kvaser CAN Channel
' Vector CAN Channel
SPEtas CAN Channel

Description
(K\taser CAN Channel on this computer

4. Select a CANMonitor device by again clicking Device - Add

CANMonitor.

“@l File Edit Wiew Project

Device Tools Window Help

IEErCEEEE e

= Remove Device

Device

\3 Computer
=2 PC Based CAN

== KvaseCharre |

= Properties Fo

Context Menu

Device, and select

52 CAN Monitor

%CCP Controller Device

%XCP Controller Device

B kwP2000 CAN Device (Flash Only)
¢ CSM DAQ Network

2 IMC DAQ Network

% IPETRONIK DAQ Metwork

Description
IVCAN bus message monitor virtual device




5. Add the .dbc file generated from the ECM Configuration Tool to CANMonitor by clicking
Device - Add CAN Database and browsing to the previously created .dbc file.

Hlﬁl File Edit View Project

Device Tools Window Help

ok s

={ Remove Device

[5)|Add CAN Database... =

Computer
= WIS2 PC Based CAN
= W52 KvaserChannel

-

& Properties Fa

CANMonitor

Ltlire:

, | = BEckE-

Look in: | | VISION Projects

MName Date modified

9/28/2011 3:18 PM
9/30/2011 5:27 PM

Type
File folder
DBC File

. Samples
2 LambdaCAMTest.dbc

1

File name: ILambdaCJ\NTest.dbc

Files of type

i : |CAN Database Files (*.dbe:"uef)

6. Enable the hardware by clicking Project = Online. The status of all of the devices should
now show a Status of Online, and a value should appear in the Data Rate column of the

Project wi

ndow.

JIEI File Edit View | Project Device Tools Window Help

-
- 2 \ehicle Manager...

tus

v Computer Proposed Values » line

E‘E PC Based C/ ne

= W52 KvaserT| M Panic Apply Base F12 ne

= WIS2 CANMGHTET Thtline

o Ml | ambdaCANTest Bctive
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7. To view data, create a new Screen File and add a Control. Click File > New - Screen File

Tools Window Help

IR [[ ) = e 6 x o - - |

Open... Ctrl+O

Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

8. Select Object > Add Control - Gauge

“ File Edit View Project | Object Dataltern Tools Window

(5] Project File
®Estrateqy File

®EEMY configuration File
ﬁ Calibration File

[ kaMm Data File
Screen File

L) ASCIT Text File
gRTF Document File

Description
VISION real-time document used for interacting with data

@ Delete Ctrl+Delete

Tile controls

m Cut
Copy
Paste

B Properties F&

DEeR@ =

Ctrl+F10

Context Menu
Track Residency
5] Clear Residency

EData List
BB stripchart Recorder

E=12D Table Grid
[E 30 Table Grid
E5tate Array
(% Gauge

1 Bar Graph

:i, Thermometer
@ LD

aLED Array
5 Seroll Bar
Oypial

i Switch

% Dashboard
CAN Trace

"Descripﬁon

Gauge




9. In the Select Data Items window open the CANMonitor file tree to view all of the available
signals. Here the O2% from Node 0x10 has been selected. Click OK to add the Data Item to
the Control.

' Select " Find

I Advanced. .. | OF I

[C1 DatakemGroups Data Item £ I Type | Canicel |
=27 CANMoritor
=& Node_{x10

“er LAM 010 CAN Signal
CAN Signal Help

Mext |
Previous |

T —

Selected Data ltems I Comments

Add |
Remove |

10. Data should be visible on the gauge.

lam@aa Lty aRE W J

02_0x10 (%)

%  CANMonitorProject

“IDefaultVehicle Zlft @B m|B] =l “‘/ % | B[ o ol ik |+ -

For Help, press F1 |— Default User |Online NUM 10/3/2011 11:46:18 AM_~
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Appendix I. Using the Lambda (0,) Sensor Simulator

The Lambda Sensor Simulator outputs currents to simulate a lambda (O,) sensor and voltages
to simulate a pressure sensor. It is plugged into a LambdaCAN* module instead of the
lambda and pressure sensors. When plugged in, if the LambdaCAN* module is operating
properly, it will report the correct currents (i.e. lambdas) and voltages (i.e. pressures) output
by the simulator.

The simulator is a useful tool to check out a system where there is a problem and it is not
known if the sensor, cable, module, or data acquisition system receiving the CAN data from
the LambdaCAN* module is the cause of the problem. The simulator checks out everything
but the sensors, however once everything else checks out okay, the focus can be put on the
sensors. A properly operating LambdaCAN* module monitors lambda sensor condition and
can calibrate the lambda sensor. An external pressure source is required to check out the
pressure Sensor.

Lambda Sensor Simulators can be returned to ECM on a schedule (1 year recommended) for
recalibration.
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Safety Warnings

In installation and use of this product, comply with the National Electrical Code and any
other applicable Federal, State, or local safety codes.

The lambda sensor is heated, gets hot, and can burn you.
Always wear eye protection when working near engines, vehicles, or machinery.

During installation, turn off the power and take all other necessary precautions to prevent
injury, property loss, and equipment damage. Do not apply power until all wiring is
completed.

Never work on a running engine.

When installing the Lambda 5220’s cabling and sensor(s) on a stopped engine, it is best to
think-out your moves before you make them.

Route and cable-tie all cables away from hot, moving, sharp, or high voltage (spark) objects.

Take into consideration the movement of the engine, chassis, and wind buffeting when
instrumenting the engine.

Clear tools away from the engine before starting.

Operate the engine only in a well ventilated area and never when you or one of your co-
workers is tired.

When operating the Lambda 5220 in a moving vehicle, the operator should keep his or her
eyes on the road.

One measure of professionalism is how much you and your co-workers can accomplish
without an injury. Always be at your professional best. Think and act with safety in mind.

55




Warranty and Disclaimers

WARRANTY

The products described in this manual, with the exception of the lambda and pressure
sensors, are warranted to be free from defects in material and workmanship for a period of
365 days from the date of shipment to the buyer. Within the 365 day warranty period, we
shall at our option repair such items or reimburse the customer the original price of such
items which are returned to us with shipping charges prepaid and which are determined by us
to be defective. This warranty does not apply to any item which has been subjected to
misuse, negligence or accident; or misapplied; or modified; or improperly installed.

The lambda and pressure sensors are considered an expendable part and as such cannot be
covered by a warranty.

This warranty comprises the sole and entire warranty pertaining to the items provided
hereunder. Seller makes no other warranty, guarantee, or representation of any kind
whatsoever. All other warranties, including but not limited to merchantability and fitness for
purpose, whether express, implied, or arising by operation of law, trade usage, or course of
dealing are hereby disclaimed.

The warranty is void if a module or the display head is opened.

LIMITATION OF REMEDY

Seller's liability arising from or in any way connected with the items sold and/or services
provided shall be limited exclusively to repair or replacement of the items sold or refund of
the purchase price paid by buyer, at seller's sole option. In no event shall seller be liable for
any incidental, consequential or special damages of any kind or nature whatsoever, including
but not limited to lost profits arising from or in any way connected with items sold and/or
services provided to buyer, whether alleged to arise from breach of contract, express or
implied warranty, or in tort, including without limitation, negligence, failure to warn or strict
liability. In no event shall the company's liability to buyer arising out of or relating to the
sale of any product or service exceed the purchase price paid by buyer to the company for
such product or service.

PRODUCT CHANGES

We reserve the right to discontinue a particular product or to make technical design changes
at any time without notice.
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ECM ENGINE CONTROL
AND MONITORING

5191 Lafayette St.

Santa Clara, CA, 95054
USA

Phone: (408) 734-3433
FAX: (408) 734-3432
Email: sales@ecm-co.com
Web: www.ecm-co.com

EC DECLARATION OF CONFORMITY

We declare under our sole responsibility that the products:

AFM1540 Lambda Module

AFM1600 Lambda and O, Analyzer

DIS1000 Display Head

EGR 4830 Analyzer

Lambda 5220 Lambda Analyzer

NOx 5210 NOx Analyzer

EGR 5230 EGR Analyzer

LambdaCAN, LambdaCANc, LambdaCANd, LambdaCANp Lambda Modules
NOXCAN, NOXCANg, NOxXCANt NOx Modules
NOx1000 NOx Module

baroCAN Module

dashCAN, dashCANc, dashCAN+, dashCAN2
appsCAN

SIM300, SIM400, SIM500, SIM600, SIM700, SIM800
BTU200

NOX/NH3 5240 Analyzer

To which this declaration relates are in conformity with the essential requirements of the following standards:

EN61326: 1997/A2: 2001 (Class A & Annex A)
EN61010-1: 2001 (Electrical Safety)

And therefore conform to the requirements of the following directives:
89/336/EEC Electromagnetic Compatibility (EMC)
72/23/EEC Low Voltage Directive (LVD)

Ronald S. Patrick

Vice President Sales
August 22, 2014


mailto:sales@ecm-co.com




ECM ENGINE CONTROL
AND MONITORING

Los Altos, CA 94023-0040 ¢ USA e (408) 734-3433 e Fax: (408) 734-3432 ¢ www.ecm-c0.com



